# Contents

1 Revision History .................................................................................................................................1  
  1.1 Revision 33........................................................................................................................................1  

2 Introduction.......................................................................................................................................2  
  2.1 Purpose..............................................................................................................................................2  
  2.2 Internal References............................................................................................................................2  
  2.3 Definitions, Acronyms, and Abbreviations.........................................................................................2  

3 Libero SoC Software Installation and Configuration........................................................................3  
  3.1 Prerequisites.......................................................................................................................................3  
    3.1.1 System Requirements..................................................................................................................3  
  3.2 Login...................................................................................................................................................3  
  3.3 Downloading the Libero SoC Software................................................................................................4  
  3.4 Installing the Libero SoC Software.....................................................................................................4  
    3.4.1 Installing the Libero SoC Software on Windows........................................................................4  
    3.4.2 Installing the Libero SoC Software on Linux..........................................................................9  
    3.4.3 Tips for Launching Libero on Linux RH Operating Systems....................................................15  
  3.5 Obtaining the Licenses.......................................................................................................................16  
    3.5.1 Libero License Options.............................................................................................................16  
    3.5.2 Obtaining Free Licenses.........................................................................................................17  
    3.5.3 Obtaining a Paid License........................................................................................................20  
    3.5.4 Retrieving Copies of Existing Licenses..................................................................................23  
    3.5.5 License Changes and Information...........................................................................................25  
  3.6 Installing Licenses.............................................................................................................................25  
    3.6.1 Installing a Node Locked Disk ID License on Windows............................................................25  
    3.6.2 To install a node-locked USB dongle license on Windows:....................................................26  
    3.6.3 Installing a Floating License on a Windows Server.................................................................27  
    3.6.4 Installing a Floating License on a Linux Server...................................................................28  
    3.6.5 Installing a Floating License on a Solaris Server..................................................................28  
    3.6.6 Connecting the Client Machines (PCs and Linux) to the License Server...............................29  
    3.6.7 Installing a Server-Based Node-Locked License for Synphony Model Compiler ME............29  
  3.7 Installation in Environments without a Consistent Internet Connection..........................................30  
    3.7.1 Change your Vault Location....................................................................................................30  
    3.7.2 Disable Internet Options.........................................................................................................31  
    3.7.3 Download Direct Cores and SgCore (SmartDebug) Cores to Populate your Vault.................31  
    3.7.4 Download Firmware Cores.....................................................................................................31  

UG9124 Software Installation and Licensing Guide Revision 33
1 Revision History

The revision history describes the changes that were implemented in the document. The changes are listed by revision, starting with the most current publication.

1.1 Revision 33

Revision 33 is published in January 2020. The following are the changes made in this document.

- Revamped the sections in this document to have them in a logical order.
- Added Purpose, References, Definition, Acronyms and Abbreviation, Prerequisites, and Login sections.
2 Introduction

Libero® SoC Software offers high productivity with its comprehensive, easy-to-learn, easy-to-adopt development tools for designing with Microsemi’s PolarFire, IGLOO2, SmartFusion2, RTG4, SmartFusion, IGLOO, ProASIC3, and Fusion families. The following table lists the Libero license types and their features.

You can download the Libero SoC Software at http://www.microsemi.com/products/fpga-soc/design-resources/design-software/libero-soc#downloads.

You must have a license to run the Libero SoC Software. See the Licensing web page to select the right license at https://www.microsemi.com/products/fpga-soc/design-resources/licensing.

Need help selecting the right license for your design? - Download the Libero License Selector Guide.

2.1 Purpose

This document provides information about how to download and install the Libero SoC Software and the prerequisites that are needed to run the application on your system. Also, it does describe how to obtain and install licenses on your system.

2.2 Internal References

- See the licensing information at, https://www.microsemi.com/products/fpga-soc/design-resources/licensing.
- View the tool and device support for the various licenses at, https://www.microsemi.com/products/fpga-soc/design-resources/licensing.
- See the Libero License Selector Guide for more information about license offerings.
- See the PCN17031 for the ceased operating system support.
- See the CN17012: Customer Notification for the Libero SoC Software license offering changes.
- See https://www.microsemi.com/applications/motor-control#ip-suite for Motor Control licenses.
- See the PDN19017: Product Discontinuation Libero USB Dongle Licenses for discontinued Libero licenses.

2.3 Definitions, Acronyms, and Abbreviations

The following table lists the Definitions, Acronyms, and Abbreviations used.

<table>
<thead>
<tr>
<th>Terms</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Libero</td>
<td>Libero SoC Design Suite</td>
</tr>
</tbody>
</table>
3 Libero SoC Software Installation and Configuration

This section explains how to install the Libero SoC Design Suite and configure.

3.1 Prerequisites

You must meet the mentioned specifications to install the Libero SoC Software on your system.

3.1.1 System Requirements

To know more information about the Product Families and Platforms; details about the current System Requirements are available at http://www.microsemi.com/products/fpga-soc/design-resources/design-software/libero-soc#device-support.

Notes:

1. Only 64-bit Windows and Linux operating systems are supported.

2. Setup instructions for using the Libero SoC on Red Hat Enterprise Linux OS are available on the Libero SoC Documents web page. As noted in that document, installation step 2 now includes running a shell script (bin/check_linux_req.sh) to confirm the presence of all required run time packages.

3.2 Login

You need an SoC login account to download the required Libero Design Suite and licenses.

To login,

1. Enter the URL in a browser, Login or Create a new Login Account. The Login page is displayed.

2. Enter the credentials in the required fields, if you are an existing user. Or you should create a new account by clicking New User to register yourself.

   Figure 1 • Login

3. Click Submit.
3.3 Downloading the Libero SoC Software

You must have Admin rights on the installation machine to install the Libero SoC Software.

To run the Libero SoC Software on your system, you need to download the software from the website.

1. Visit the Libero SoC Software page at Libero SoC Software Design. The Libero SoC v12.0 and later page is displayed.

2. Go to the Downloads tab on this page, and click the latest Libero SoC software download link. The download page is displayed.

3. Download the Libero SoC software to your system.

3.4 Installing the Libero SoC Software

You can install the Libero SoC Software on your system for Windows or Linux.

**Note:** You must have the Administrator rights on the installation machine to install the Libero SoC Software.

3.4.1 Installing the Libero SoC Software on Windows

Install the Libero SoC Software from a DVD or over the web. The installation process varies slightly, depending on which method you choose.

**Note:** If you have a USB Hardware Key Dongle license, DO NOT attach the USB dongle prior to installing Libero or USB drivers. The USB dongle must be attached after the software and USB driver installation. See "Installing a Node-Locked USB Dongle License on Windows" on page 17 regarding USB Driver installation.

3.4.1.1 Installing the Software from the Web (Recommended)

Download the Libero SoC software from website to your local machine. Launch the EXE file, select the features you wish to install. The features that you select are installed on your local machine. There are options provided for configuring the features. Either you can select Default Components or Customize Components.

To install the Libero SoC Software over the web,

1. Navigate to the download page, Windows EXEs Download. The download page is displayed.
2. Choose one of the download options depending on your need.

3. Click the **Download Libero SoC (Windows)** link.

4. Extract the `.exe` file from the downloaded folder.

5. Click on the shortcut link and follow the installation instructions.

### 3.4.1.2 Installing the Software from a DVD (or large ZIP file from the Web)

To install the software from a DVD,

1. Insert the Libero SoC Software DVD or double-click the ZIP file you downloaded from the web.

2. Unzip/extract the ZIP archive.
3. Run or double-click the `setup.exe` in the extracted folder. The **Libero SoC <version> InstallAnywhere Wizard** appears.

**Figure 2 • Libero InstallShield Wizard**

4. Click **Next**. The **License Agreement** appears.

5. Read the License Agreement and select the **I accept the terms in the license agreement** check box.
6. Click **Next** to continue. The **Destination Folder** appears and shows the default installation location in c:\ drive.

**Figure 4 • Choose Install Directory**

7. Click **Next** to accept the default installation location or click **Choose** to navigate to a different installation location and then click **Next**.

8. Accept the default installation location to install the common files or click **Choose** to navigate to a different installation location and then click **Next**.

**Figure 5 • Choose Common Directory**
9. Choose the Install Set: Libero SoC: Installs all the features by default. The Complete Setup is recommended for beginners. It installs all Libero SoC program features, but also requires the most disk space. Custom: Allows you to choose the features to install depending on the design flow. The Custom Setup allows you to pick and choose which program feature to install.

**Figure 6 • Install Set**

10. Click Libero SoC to install as it is suggested for beginners who use this software. The Pre-Installation Summary is displayed.

**Figure 7 • Pre-Installation Summary**

11. Click Install. The installation dialog box appears.
**Note:** Beginning with the Libero SoC v11.8 release, both ModelSim ME and ModelSim ME Pro are installed by default. After installation, ModelSim ME is the default simulator in the Tool Profile (Project > Tool Profile). If ModelSim ME Pro, and not ModelSim ME, is the desired simulator for you, change the Simulator in the tool profile (Project > Tool Profile) to point to ModelSim ME Pro. ModelSim ME and ModelSim ME Pro are identified by different feature lines in the Microsemi Libero SoC license file. Ensure that the Libero SoC license file has the feature line that supports the specific ModelSim version you want to use.

12. Click Done, when the InstallShield Wizard Completed dialog box appears.

13. Click Start > All Programs > Microsemi Libero SoC v12.3 > About Your Installation to confirm whether all tools and libraries are installed.

### 3.4.2 Installing the Libero SoC Software on Linux

You can install the Libero SoC Software on Linux in GUI and Console modes.

**Note:** You may see the Libero SoC Linux Environment Setup User Guide where it details how to set up the Linux environment.

#### 3.4.2.1 Installing the Libero SoC Software in the GUI Mode

Perform the following steps to install the Libero SoC Software in GUI mode. This is the default installation procedure.


2. Extract the *.tar.gz file at the Linux prompt as follows:

   ```
   % gzip -d LiberoSoC_<Version>.tar.gz
   % tar xvf Libero<Version>.tar
   ```

3. Type the following to run the installer at the Linux prompt: `% ./LiberoSoC<version>Linux.bin` The Install Anywhere Introduction page appears.

**Figure 8 • Install Anywhere Introduction Page**
4. Click **Next** to continue. View and accept the License Agreement.

**Figure 9 • License Agreement**

5. Enter the Installation folder location. Click **Next** to accept the default location or click **Choose** to navigate to a location and then click **Next**.

**Figure 10 • Libero on Linux Installation Directory**
6. Choose a **Common File Directory** as shown in the following figure. You can actually store common files that are shared across different versions of Libero. The default Common File directory location is `/usr/local/microsemi/common`.

*Figure 11 • Libero on Linux Installation Directory*

7. If you have previously created such a directory, enter its path. If this is your first Libero installation on this machine, enter or browse to a common directory that you intend to share with all future Libero installations.
8. Click **Next** to continue after selecting the components you want to install.

**Figure 12 • Choose Install Set**

**Figure 13 • Choose Install Custom Set**
9. Review the **Pre-Installation Summary** dialog box to see the selected components for installation.

**Figure 14 • Pre-Installation Summary**

![Pre-Installation Summary](image)

10. Click **Install** to continue your installation. The progress bar appears.

11. Click **Done** to complete your installation.

For information on installation in console mode, see "Installation in Console Mode" on page 36.

### 3.4.2.2 Installing the Libero SoC Software in Console Mode

Perform the following instructions to install the software in Console mode:

1. Type the following command:
   ```bash
   ./LiberoSoC<version>Linux.bin -i console
   ```

   The **Console Mode Installation** page is displayed.

**Figure 15 • Console Mode Installation Screen**

[Console Mode Installation Screen Image]

---

UG9124 Software Installation and Licensing Guide Revision 33
2. Press Enter to continue. The License Agreement is displayed.

**Figure 16 • License Agreement**

```
License Agreement

Installation and use of Libero SoC v12.3 requires acceptance of the following License Agreement:

MICROSEMI SOC CORP. LIBERO SOFTWARE LICENSE AGREEMENT

A) MICROSEMI SOC CORP. CONTROLLING USE RESTRICTIONS AND TERMS AND CONDITIONS FOR ASSOCIATED THIRD PARTY LICENSE AGREEMENTS
B) THIRD-PARTY LICENSE AGREEMENTS FOR PRODUCTS INCLUDED WITH LIBERO
   C) SYNSYS SOFTWARE LICENSE AGREEMENT FOR SIMPLICITY SOFTWARE (EXHIBIT A)
   D) Mentor Graphics Model Technology (EXHIBIT B)
   E) C-ARES Library (EXHIBIT C)
   F) curl (EXHIBIT D)
   G) OpenSSL (EXHIBIT E)
   H) Tcl/Tk (EXHIBIT F)
   I) Xmem (EXHIBIT G)
   J) zlib Library (EXHIBIT H)
   K) MCTK (EXHIBIT I)
   L) gSOAP (EXHIBIT J)
   M) CoN (EXHIBIT K)

Note: For the remainder of this document, the terms &you;& and &licensee& shall

PRESS <ENTER> TO CONTINUE:
```

3. Review the license agreement. The installer displays the license agreement one screen at a time.

4. Press ENTER to view each page and continue. Enter Y at the end of the agreement to accept and continue.
   - Specify the installation folder. Do not accept the default path. You must enter the same Microsemi parent directory as your past Libero installations. The installer creates a version-specific sub-directory under this parent directory. If this is your first Libero installation, enter a Microsemi parent install directory under which you intend to install all future Libero installations. Microsemi recommends using `/usr/local/microsemi/libero` as your parent installation directory.
   - Enter Y to confirm the installation folder. Enter the absolute path for the Libero Common Directory. A Libero common directory is shared by multiple versions of Libero. Microsemi recommends that you use the common directory `/usr/local/microsemi/common`.
   - Enter the absolute path for the Libero Common Directory. A Libero common directory is shared by multiple versions of Libero. Microsemi recommends that you use the common directory `/usr/local/microsemi/common`.
   - Confirm the Absolute Path for the Libero Common Directory.
   - Enter the number that corresponds to the software features you want to install.

**Figure 17 • Choose Common Directory**

```
Choose Install Directory

Please enter the same root directory as your past Libero SoC installations. The installer will create a version-specific subdirectory under this root directory. If this is your first Libero SoC installation, please enter a root directory under which you intend to install all future Libero SoC installations.

Where would you like to install:

Default Install Folder: /usr/local/microsemi/Libero_v123

ENTER AN ABSOLUTE PATH, OR PRESS <ENTER> TO ACCEPT THE DEFAULT:

/soft/soatext14/user_joe/microsemi

INSTALL FOLDER IS: /soft/soatext14/user_joe/microsemi

IS THIS CORRECT? [Y/N]:
```
• Review the **Install Set**. Enter the number corresponding to the **Install Set** you want to install.

**Figure 18 • Install Set Selection**

```
Choose Install Set

Please choose the Install Set to be installed by this installer.
.
1. Libero SoC

ENTER THE NUMBER FOR THE INSTALL SET, OR PRESS <ENTER> TO ACCEPT THE DEFAULT

: 1
```

• Press **ENTER** to continue. The pre-installation summary is displayed.

**Figure 19 • Pre-installation Summary**

```
Enter a Common Directory

Please enter a directory for installing common files to be shared across different versions of Libero SoC. If you have previously created such a directory, please enter its path. If this is your first Libero SoC installation, please enter a common directory which you intend to share with all future Libero SoC installations.

Common Install Path: (Default: n/a): /
```

• Press **Enter** to begin the installation.

• Obtain and set up your license according to the instructions in "Obtaining Licenses" on page 5.

### 3.4.2.3 Installing the Service Pack

Service Packs are incremental, and must be installed on top of the previous release or releases.

To verify your Libero SoC version, from the Help menu, click **About Libero**.

**IMPORTANT:** `<Libero_release>_Lin.tar.gz` must be placed in the `$ALSDIR/Libero` directory and the installation must take place on the local system.

1. Log in with read/write permission to system on which Libero SoC is installed.
2. Download `<Libero_release>_Lin.tar.gz` into `$ALSDIR/Libero`. `<Libero_release>_Lin.tar.gz` is now located at the same level as adm/, bin/, data/, and so on.
3. Type: `tar xzvf <Libero_release>_Lin.tar.gz`
4. Type: `/wsupdate.sh` to complete the installation of the update.

### 3.4.3 Tips for Launching Libero on Linux RH Operating Systems

See *How to Set Up Your Linux Environment for Libero* for detailed instructions on how to launch Libero on Linux RH operating systems.
3.5 Obtaining the Licenses

You must have a license to run the Libero SoC Software. Navigate to this URL to learn about available licenses, how to purchase new licenses or renew existing licenses, and how to obtain evaluation licenses.

https://www.microsemi.com/products/fpga-soc/design-resources/licensing#overview

Do you need help with selecting a right license for your design? Use the Libero License Selector Guide, a license selection tool that enables you to select the right license option based on multiple parameters such as FPGA/SoC device, Libero version, Operating System, and so on.

3.5.1 Libero License Options

Two license types are offered: node-locked or floating. A node-locked license is locked to a specific hard disk ID or movable USB hardware key dongle. A USB dongle with the accompanying license file allows the software to operate on any PC to which the dongle is attached and the license file and software are installed.

View the tool and device support for the various licenses at https://www.microsemi.com/products/fpga-soc/design-resources/licensing.

Node-locked license installation is covered in "Installing Licenses" on page 16.

Notes:

1. Node-locked licenses are supported on Windows platform and Floating license are supported on WindowsL, Linux, and Solaris platforms.

2. Remote access is not supported for node-locked Evaluation, Gold, Platinum, and Silver licenses. However, it supports a standalone license.

A floating license is typically installed on a network server (Windows, Linux, or Solaris) and allows networked client PCs to access the license from the server. The Client PCs can be Windows or Linux OS. Client seats can be purchased to allow up to 999 users to run the Libero software simultaneously.

Note: Node-locked and floating licenses do not support virtual machine servers.

Libero license manager and vendor daemons for all supported network server platforms are available at https://www.microsemi.com/products/fpga-soc/design-resources/licensing#downloads.

Note: If you want to use 64-bit lmgrd you can obtain it directly from Flexera. Floating license installation is covered in "Installing Licenses" on page 16.
3.5.2 Obtaining Free Licenses

Microsemi supports two types of free licenses such as Evaluation and Silver licenses. The following figure shows the Silver License web page. Follow the steps to generate a free license.

Figure 20 • Silver License Web Page

Provide the login details on the Microsemi SoC Customer Portal web page. If you are a new user, register and create an SoC portal account.
Click **Request Free License** on the Microsemi SoC Licensing web page to generate a free license.

**Figure 21 • Request for a Free License Web Page**

To obtain a FREE Libero Evaluation or Silver license, click the button below. The following Evaluation and Silver licenses support Libero SoC: PolarFire, Libero SoC v.18.8, and above versions only Libero ICE v.18.2 SP1, Libero SoC v.18.7 SP1) and lower versions do not support Evaluation and Silver licenses. If you are using one of these Libero ICE or Libero SoC versions, you need to purchase Gold, Platinum or Standalone license. To know the ordering part number of the Libero license, refer the Licensing page.

**Software ID for the Purchased Product**

Please enter your unique software ID number to generate a Libero Gold or Platinum license or paid DirectCores.

**Licensing Resources**

The Licensing Resources section includes an overview of all licenses, documentation, trouble shooting, ordering information and support recommendations.

**3.5.2.1 How to obtain a Disk ID:**

The DISK ID is the computer hard drive's serial number, also called Disk Serial Number. It is typically the "C" drive in your computer. The Disk ID is an 8 character hexadecimal number of the form, xxxx-xxxx, similar to "A085-AFE9". The requested license is sent to you within 45 minutes. If you select a Node Locked License, the registration page that requires the hard disk ID of the PC where the Libero SoC Software is installed. If you are not sure how to find the hard disk ID, click the **How to find a DiskID** link to locate the ID and provide the Disk ID in the entry field.

To obtain your computer's Disk ID, type the following at a DOS or Command Prompt:

```
C:> Vol C:
```
Enter your C drive’s Disk ID number into the license registration page window where indicated and click **Submit**.

Input the Disk ID number, and click **Submit**.

**Figure 23 • License Disk ID**

How to obtain a MAC ID

If you select a floating license type, the registration window requires your MAC ID for your Windows or Linux PC, and it requires the Host ID for your Solaris PC or Server.

*Linux Node Locked or Floating*

If you are not sure how to find the MAC ID, click the **How to find a MAC ID** link to locate the ID and provide the **MAC ID** in the ID entry field.

**Figure 24 • MAC ID Based Registration Web Page**

To obtain the MAC ID, from the Command Prompt type:

```
/sbin/ifconfig
```

The Ethernet/MAC ID address will be displayed. The MAC ID address is a twelve character hexadecimal number, similar to "00A0C982BEE3". Enter your MAC ID into the registration page window where indicated.
Windows Floating or Synplicity "Server-Based Node-Locked" (SBNL) Licenses

To obtain the PC MAC ID, type the following at a DOS or Command Prompt:

C:> lmutil lmhostid

You can also use:

C:> <path_to_actel_installation\bin\lmhostid>

The Ethernet/MAC ID address is displayed. The MAC ID address is a twelve character hexadecimal number, similar to "00A0C982BEE3". Enter the 12 character MAC ID into the registration page window where indicated.

In some PC configurations, there can be more than one MAC ID. Use the MAC ID that you know will be the "active" ID. Some users may configure their laptops to have the wired MAC ID for docked laptop use and the wireless MAC ID for undocked use. Tools using the MAC ID depend on the MAC ID being active for use.

When finished, click Submit.

**Figure 25 • Registration Complete**

Print or write down the Software ID on the Registration Confirmation web page. Normally the license is generated and sent to your email address in less than 45 minutes. The License.dat file is an attachment to the email.

When the email and license arrive, follow the license installation instructions in "Installing Licenses" on page 16 of this guide.

### 3.5.3 Obtaining a Paid License

You can purchase the Libero Gold, Platinum, Standalone, and Archival licenses licenses. Also, Microsemi has Paid DirectCores, Video SolutionCores, and MotorControl SolutionCores.

Visit [https://www.microsemi.com/product-directory/design-resources/1711-licensing](https://www.microsemi.com/product-directory/design-resources/1711-licensing) to see all available license types.

Upon receipt of the purchase order, you will receive a SW ID document from Microsemi through an email, which contains the SW ID# number and the instructions to generate the required license.

For USB license type, you will be shipped USB dongle hardware and a software DVD, not the SW ID attached to the DVD. The Software ID number for Libero licenses is in the format LXXX-XXXX-XXXX. The Software ID for Paid DirectCores is in the format of CXXX-XXXX-XXXX. The Software ID for paid Video SolutionCores is in the format of VXXX-XXXX-XXXX. The Software ID for paid MotorControl SolutionCores is in the format of
MXXX-XXXX-XXXX Do not generate the USB dongle license until you receive the USB dongle hardware from Microsemi.

**Note:** The Libero SoC Software DVD is not available with node locked or floating licenses. It is available only with USB node-locked licenses.

**Note:** Starting from 4/16/2019, Microsemi discontinued USB Dongle license for Gold, Platinum, Gold Archival and Platinum Archival licenses because Mentor has discontinued support for the USB dongle license. See the PDN19017: Product Discontinuation Libero USB Dongle Licenses for discontinued Libero licenses.

Enter this Software ID number in the Register Purchased Product window, as shown in the following figure and click **Software ID for the Purchased Product**.

**Figure 26 • Register Purchased Product Web Page**

Depending on the type of license you purchased, depending on the Software ID you provide, the web page will ask you for a hard Disk ID, USB Dongle number or MAC ID.

If necessary, determine your DiskID or MAC ID number, enter it into the window, and click **Submit**.
3.5.3.1 How to Obtain a USB Dongle License

If you select a USB Dongle license type, the registration window requires Flex ID available on the dongle key. The following shows an example of the USB Dongle number.

**Figure 27 • USB Dongle License Registration Web Page**

![USB Dongle License Registration Web Page](image)

**Note:** The Flex ID information will be available on the USB Dongle hardware that was shipped by Microsemi.

**Figure 28 • Identifying the USB Dongle Hardware Key Number**

![Identifying the USB Dongle Hardware Key Number](image)

The Registration Confirmation web page appears when you click **Submit**. Your license will be emailed to you, usually within 45 minutes.
When the email and license arrive, follow the license installation instructions in the *Installing the Libero SoC Software* of this guide.

**Figure 29 • Registration Confirmation Web Page**

3.5.4 Retrieving Copies of Existing Licenses

You can obtain the copies of licenses from the Microsemi website and Customer Portal.

1. If you are the registered owner of a license, go to your Microsemi Portal Account at http://soc.microsemi.com/Portal/DPortal.aspx?v=1.
2. Click the **Licenses & Registration** link. A list of your software licenses is displayed, both current and expired.

**Figure 30 • License and Registration**
3. Click the link under Software ID of the desired license and click the Download License button to obtain a copy.

**Figure 31 • Software ID Details**

3.5.5 License Changes and Information

If you purchased a license, then some license changes can be performed.

- Change the owner of a license from one person to another. The new licensee must have a Microsemi Portal Account
- Change the Disk ID for a license
- Change the MAC ID for a license
- Change the USB Dongle ID for a license
- Additional email ids can be added to a license registration

The registered owner of a license will be notified 30 days, 15 days, and the last day in advance of the license expiration date. An email will also be sent on the expiration date. There is no renewal for free license. Consider purchasing an annual license after the evaluation period.

3.6 Installing Licenses

After you have registered for a license on the Microsemi website, your license is automatically emailed to the address you provided. A License.dat file is attached to the email.

**Note:** You must have Admin rights on the installation machine to install the Libero SoC Software and to set up licensing.

3.6.1 Installing a Node Locked Disk ID License on Windows

Perform the following steps to install a node locked disk ID license on Windows.
3.6.1 To install a node locked disk ID license for Windows:

1. Create a folder Flexlm in C drive and save the License.dat file in that folder.
2. Open your Environment Variables dialog box.
   a. Right-click Computer and choose Properties to open the System dialog box.
   b. Click Advanced System Settings to open the System Properties dialog box.
   c. Click the Advanced tab.
   d. Click the Environment Variables button.
   a. In windows Search, select Settings (Windows key +w) and search for Environment Variable.
   b. Double-click the environment variable for your account to open the Editor.
   a. Opens File Explorer, right-click This PC and select Properties
   b. Click Advanced System Settings and Click Environment Variables
   If LM_LICENSE_FILE is already listed in User variables, proceed to Step 3. If not, go to Step 5.
3. Select it, then click Edit.
4. Add the path to the Microsemi License.dat after any existing Variable value, separated with a semicolon (no space), or replace the existing Value.
   Go to Step 10.
   If LM_LICENSE_FILE is not listed in USER VARIABLES:
5. Click New under User Variable to create a new user variable. The New User Variable dialog box appears.
6. Type LM_LICENSE_FILE in the Variable name field.
7. Type c:\flexlm\License.dat in the Variable value field (or the path to where you installed the License.dat file). Note: Path to the installed license software is case sensitive; check for the case of the folder path in which the license is saved.
8. Click OK.
9. Click OK to save new Environment Variables and return to System Properties.
10. Click OK to exit.

Installation is complete. Libero and all installed tools that require licenses are ready for use.

3.6.2 To install a node-locked USB dongle license on Windows:

1. Create a folder named flexlm under your c:\ drive.
2. Save the License.dat file in the flexlm folder. You can save the License.dat file in a different folder; if you do so, make sure the correct path is defined in LM_LICENSE_FILE.
3. Open your Environment Variables dialog box.
   a. Right-click Computer and choose Properties to open the System dialog box.
   b. Click Advanced System Settings to open the System Properties dialog box.
   c. Click the Advanced tab.
   d. Click the Environment Variables button.
a. In Windows Search, select **Settings** (Windows key +w) and search for **Environment Variable**.

b. Double-click the environment variable for your account to open the Editor.

a. Click **Advanced System Settings** and Click **Environment Variables**

   If **LM_LICENSE_FILE** is already listed in User variables, proceed to Step 4. If not, go to Step 6.

4. Click **New** under User Variable to create a new user variable. The New User Variable dialog box appears.

5. Type **LM_LICENSE_FILE** in the Variable name field.

6. Type `c:\flexlm\license.dat` in the Variable value field. Do not put spaces in the path.

7. Click **OK**. Proceed to Step 10.

   If **LM_LICENSE_FILE** is already listed in User Variables:

8. Select the existing **LM_LICENSE_FILE** and click **Edit**.

9. Add the path to the Microsemi License.dat after any existing variable value (separated by a space) or replace the existing value.

10. Click **OK**.

11. Click **OK** to save the new Environment Variables and return to System Properties.

12. Click **OK** to exit.

13. Attach the USB dongle hardware that was sent by Microsemi to your PC.

### Dongle Driver Version Update

The Libero SoC Installer does not install the FLEXLM drivers for the USB dongle. If you use a dongle-based Libero SoC license, you are responsible for installing the current version of the dongle driver.

**Note:** Before installing the USB drivers, Microsemi recommends that you download and run the FlexLM Cleanup Utility (3.9 MB) to remove any older, incompatible FlexLM drivers currently on your system.

To run the Libero SoC releases with a USB dongle license, you need to update the dongle driver version to the current version.

1. Download the current dongle driver **SCL_FLEXID9_Installer.exe** from: https://www.microsemi.com/product-directory/design-resources/1711-licensing#downloads.

2. After download, run the **SCL_FLEXID9_Installer.exe**.

3. Follow the prompts to complete the installation.

4. Restart your system after installation for the dongle driver version to take effect.

### 3.6.3 Installing a Floating License on a Windows Server

To install a floating license on a Windows server,

1. On the SERVER machine, save the **License.dat** file into a flexlm folder on your `c:\` drive.

2. Download the required license manager daemons to your server platform from https://www.microsemi.com/product-directory/design-resources/1711-licensing#downloads. In the License Server Daemons section, and select the correct platform download. We recommend placing these files into the same location as the License.dat file.

3. Open **License.dat** and edit the SERVER line by replacing `<put.hostname.here>` with your hostname. Do not include the brackets. Edit the port number (1702), if necessary, to any unused port.
4. Libero floating licenses include Libero, Synplify Pro ME, Identify ME, Synphony Model Compiler ME and ModelSim ME tools. Edit each VENDOR and DAEMON line with the correct path to each vendor daemon and then save the License.dat file. For example: VENDOR snpslmd C:\flexlm\snpslmd DAEMON actlmd C:\flexlm\actlmd

5. Login to the SERVER machine and run the following command from the command prompt to start the lmgrd License Manager on the server machine:
C:\flexlm\lmgrd -c C:\flexlm\License.dat Alternatively, if you prefer to have the License Manager output written to a Logfile, then run the following command at the command prompt:
C:\flexlm\lmgrd -c <path_to_License.dat>/License.dat -l <path_to_logfile>/license.log

3.6.4 Installing a Floating License on a Linux Server

1. On the SERVER machine, save the License.dat file.

2. Download the required license manager daemons for your server platform from http://www.microsemi.com/products/fpga-soc/design-resources/licensing#downloads. In the License Server Daemons section, select the correct platform download. Microsemi recommends placing these files into the same location as the License.dat file.

3. Open License.dat using any editor. Edit the SERVER line by replacing <put.hostname.here> with your machine Hostname. Do not include the brackets.

4. Libero Linux floating licenses include Libero, Synplify Pro ME, Identify ME, Synphony Model Compiler ME and ModelSim ME tools. Edit each VENDOR and DAEMON line with the correct path to each vendor daemon and then save the License.dat file.

5. Login to the SERVER machine and run the following command to start the License Manager:
<path_to_lmgrd>/lmgrd -c <path_to_License.dat>/License.dat
Alternatively, if you prefer to have the License Manager output written to a Logfile, then run the following command at the command prompt:
<path_to_lmgrd>/bin/lmgrd -c <path_to_License.dat>/License.dat -l
<path_to_logfile>/license.log

3.6.5 Installing a Floating License on a Solaris Server

Libero SoC software does not run on Solaris. Solaris support is only provided for license server applications (License Manager Only). The Solaris License Manager (lmgrd) serves Standalone Libero SoC floating licenses only.

1. On the SERVER machine, save the License.dat file.

2. Download the required license manager daemons for your server platform from http://www.microsemi.com/products/fpga-soc/design-resources/licensing#downloads. In the License Server Daemons section, select the correct platform download. Microsemi recommends placing these files into the same location as the License.dat file.

3. Open License.dat using any editor. Edit the SERVER line by replacing <put.hostname.here> with your machine Hostname. Do not include the brackets.

4. Standalone Libero SoC floating licenses include Libero SoC feature only.

5. Login to the SERVER machine and run the following command in a command terminal to start the license manager:<path_to_lmgrd> /lmgrd -c <path_to_License.dat>/License.dat
Alternatively, if you prefer to have the License Manager output written to a Logfile, then run the following command at the command prompt:
<path_to_lmgrd>/lmgrd -c <path_to_License.dat>/License.dat -l
<path_to_logfile>/license.log

3.6.6 Connecting the Client Machines (PCs and Linux) to the License Server

For Client machines where the FPGA design work will be done, Libero is available for Windows and Linux operating systems.

3.6.6.1 To connect the PC Client to a Windows or Linux license server:

From Control Panel > System > System Properties (Advanced tab) > Environment Variables. Add or modify LM_LICENSE_FILE to include port@hostname:

- Variable Name: LM_LICENSE_FILE
- Value: port@hostname. Example: 1702@sage

For Synplify Pro, to check out a license, add or modify one of the following two environment variables, depending on the version of Synplify Pro used:

- SNPSLMD_LICENSE_FILE - For Synopsys tools released in September 2010 and later (2010.09).
  - Variable Name: SNPSLMD_LICENSE_FILE
  - Variable Value: <port@hostname> Example: 1702@sage

- SYNPLCTYD_LICENSE_FILE - For Synplify Pro releases before September
  - Variable Name: SYNPLCTYD_LICENSE_FILE
  - Variable Value: <port@hostname> Example: 1702@sage

3.6.6.2 To connect the Linux Client to a Windows, Linux or Solaris license server:

Use the following commands to set the environment variables on the Linux CLIENT machine:

```
setenv LM_LICENSE_FILE <port@hostname>
```

Example: setenv LM_LICENSE_FILE 1702@sage

For Synplify Pro, to check out a license, add or modify one of the following two environment variables, depending on the version of Synplify Pro used:

- SNPSLMD_LICENSE_FILE - For Synopsys tools released in September 2010 and later (2010.09).
  ```
  setenv SNPSLMD_LICENSE_FILE <port@hostname>
  ```
  Example: setenv SNPSLMD_LICENSE_FILE 1702@sage

- SYNPLCTYD_LICENSE_FILE - For Synplify Pro releases before September 2010.
  ```
  setenv SYNPLCTYD_LICENSE_FILE <port@hostname>
  ```
  Example: setenv SYNPLCTYD_LICENSE_FILE 1702@sage

3.6.7 Installing a Server-Based Node-Locked License for Synphony Model Compiler ME

**Prerequisite Software:** In order to run Synphony Model Compiler ME, you must have MATLAB/Simulink by MathWorks installed with a current license. You cannot run Synphony Model Compiler ME without MATLAB/Simulink.

**Synphony Model Compiler ME licenses are included with Libero floating licenses:** You do not need to install a separate floating license for Synphony Model Compiler ME.

If you are using a Libero Node Locked license, then follow the instructions below

**Note:** Installation and setup of this license is different from other Microsemi licenses.

Install Synphony Model Compiler ME software before installing this license file.
A Symphony Model Compiler ME license is a “floating” license. If your PC has a license manager running, it is important to turn off the license manager before proceeding. Visit http://www.flexerasoftware.com/support.htm#acresso and consult the FLEXnet Publisher Lmgrd and Utilities Manual for installation instructions.

### 3.6.7.1 Installing the IP Paid Licenses

After you receive the paid IP license from Microsemi, append the text at the bottom of the original Libero license file. For example, if you have a node locked paid IP license, add this text in Libero node locked license.

### 3.7 Installation in Environments without a Consistent Internet Connection

If you prefer to disconnect from the Internet while using Libero we encourage you to re-connect occasionally and manually Check for SW Updates and Download New IP Cores to take advantage of new features, enhancements and fixes.

Install the software as described in "Installing Libero SoC Software" on page 22.

### 3.7.1 Change your Vault Location

If you install the Libero SoC Software onto a network drive for multi-user access, you may want to specify a Vault location that can be shared by all users.

**Note:** All users must have write permission to the shared vault location.

Note: Microsemi recommends a minimum disk space of 1.2 GB for the vault location. To change your Vault location:

1. Launch Libero SoC.
2. From the **Project** menu choose **Vault/Repositories Settings**.
3. Click **Vault location**.
4. Enter a new **Vault location** in the text field.
5. Click **OK**.

To install Mega Vault,

**Download and set-up of a complete Vault for new installations**

1. Using the link above, save the .zip file of the entire vault to your local machine (For example, c:\temp).
2. Unzip the file to a folder on your local machine (For example, c:\vault).

**Set the path to the vault as follows:**

**For Libero PolarFire v2.1 and later (Windows only):**

1. Run the **setup.exe** installer (included in the MegaVault zip file) to complete vault installation.
2. Click **Project** then **Vault/Repositories Settings**... The **Vault/Repositories Setting** dialog box is displayed.
3. Select **Vault location** from the options on the left pane.
4. Select a path for Vault installation folder (by default it will be C:\Microsemi\PolarFire_v2.1_MegaVault, however during installation you can select your preferred path).
3.7.2 Disable Internet Options

You can disable Libero access to the Internet, or disable the automatic software update features. This is useful if your Internet access is inconsistent. To do so:
1. In the Project menu choose Preferences to open the Preferences dialog box.
2. Click Software update and choose the Do not check for updates or remind me at startup radio button as shown in the following figure.
3. Click Internet Access and uncheck Allow Access to Internet as shown in the following figure.
4. Click OK to continue.

3.7.3 Download Direct Cores and SgCore (SmartDebug) Cores to Populate your Vault

When you maintain a constant Internet connection, you are prompted for download of Cores required for your Libero project. If you plan to disconnect from the Internet, you must populate your vault after initial Libero SoC installation and before you disconnect from the Internet. To do so:
1. Launch the Libero SoC Software.
2. From the View menu choose Windows > Catalog to open the Catalog.
3. Click Download them now. The download make take several minutes, depending on your Internet speed. The completion percentage is tracked in the progress bar.
   The Download them now button disappears when the download is complete. The new cores are available in your Catalog.

You may also download the Direct Cores and Sgcores at http://www.actel-ip.com/cwps/download_index/DirectCore and http://www.actel-ip.com/cwps/download_index/SgCore.

3.7.4 Download Firmware Cores

You can download Firmware Cores and store them in the same vault location as the DirectCore and Sg (SmartDesign) cores:
1. Access the Firmware Catalog from All Programs > Microsemi > Libero SoC_<version> FirmwareCatalog.
2. Click Download them Now to download the Firmware Cores. You may also download the Firmware Cores at http://www.actel-ip.com/cwps/download_index/Firmware.

After the initial setup is completed following the steps above, an Internet connection is no longer required for Libero operation. However, most documentation and silicon user's guides are available only from our website at http://www.microsemi.com/products/fpga-soc/design-resources/design-software/libero-soc#documents. Note that without an Internet connection, some hyperlinks in Libero log windows will be inaccessible.
Microsemi’s product warranty is set forth in Microsemi’s Sales Order Terms and Conditions. Information contained in this publication is provided for the sole purpose of designing with and using Microsemi products. Information regarding device applications and the like is provided only for your convenience and may be superseded by updates. Buyer shall not rely on any data and performance specifications or parameters provided by Microsemi. It is your responsibility to ensure that your application meets with your specifications. THIS INFORMATION IS PROVIDED "AS IS." MICROSEMI MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS CONDITION, QUALITY, PERFORMANCE, NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL MICROSEMI BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL OR CONSEQUENTIAL LOSS, DAMAGE, COST OR EXPENSE WHATSOEVER RELATED TO THIS INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROSEMI HAS BEEN ADVISED OF THE POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST EXTENT ALLOWED BY LAW, MICROSEMI’S TOTAL LIABILITY ON ALL CLAIMS IN RELATED TO THIS INFORMATION OR ITS USE WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, YOU PAID DIRECTLY TO MICROSEMI FOR THIS INFORMATION. Use of Microsemi devices in life support, mission-critical equipment or applications, and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend and indemnify Microsemi from any and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any Microsemi intellectual property rights unless otherwise stated.

![Microsemi logo](image)

Microsemi Corporation, a subsidiary of Microchip Technology Inc. (Nasdaq: MCHP), and its corporate affiliates are leading providers of smart, connected and secure embedded control solutions. Their easy-to-use development tools and comprehensive product portfolio enable customers to create optimal designs which reduce risk while lowering total system cost and time to market. These solutions serve more than 120,000 customers across the industrial, automotive, consumer, aerospace and defense, communications and computing markets. Headquartered in Chandler, Arizona, the company offers outstanding technical support along with dependable delivery and quality. Learn more at [www.microsemi.com](http://www.microsemi.com).